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It ’s easy as 123… as our newsletter continues into the new year unabated.  And the updates seem to swing into full force 
with various updates for both Excel and Power BI – including a new way to connect Excel to Power BI!

Our normal features all remain primed and ready: you can check out our latest Beat the Boredom Challenge, plus there’s 
also Charts & Dashboards, Visual Basics, Power Pivot Principles, Power Query Pointers and the A to Z of Excel functions 
series.  We round out this month’s newsletter with CTRL + ALT + SHIFT  keyboard shortcuts and ruminate over what the 
heck ‘Outdent’ means...

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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The Automate tab is no longer just on the web browser.  Since the 
beginning of the year, the Automate tab is now available for all eligible 
enterprise users in Excel for Windows and Mac.  Previously, this tab was 
only available in Excel on the web. 

With this new tab, you may create and modify scripts that automate 
your repetitive tasks using Office Scripts.  Furthermore, you can enhance 

your workbook by connecting popular applications like Microsoft Teams 
or SharePoint to build workflows with Power Automate.  These may be 
combined, for example, to have Power Automate schedule your Office 
Script.  Microsoft has confirmed that this tab represents the first stage of 
uniting automation solutions across platforms. 

To view and run scripts: 

	 •	 open any workbook in Excel for Windows or for Mac and select the Automate tab

	 •	 select a script from the gallery or from the ’All Scripts’ task pane

	 •	 click the Run button on the script’s detail page to run the script.  

Power Automate Now in Excel for Windows and Mac
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Here’s how to make a new script:

	 •	 open any workbook in Excel for Windows or for Mac and navigate to the Automate tab

	 •	 all the scripts in your workbook are available, as well as various samples from Microsoft

	 •	 make your own script by selecting the ’New Script’ button

	 •	 to modify an existing script, select Edit on the script’s details page, or select the pencil icon by hovering over any script in the ’All 	
	 	 Scripts’ task pane.

To connect your automations to other applications, proceed as follows:

	 •	 in Excel on the web, Excel for Windows or Excel for Mac, open an Excel workbook

	 •	 select Automate -> Automate a Task

	 • 	 select the template you wish to use
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	 •	 sign in, provide the required information, and then select the Create button.

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our readers 
engaged, we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One 
suggested solution may be found later in this newsletter.  Here’s this month’s…

As we have shown numerous times, it’s possible to introduce conditional 
number formatting into Excel cells using the basic number formatting 
options, e.g. to display numbers such as 10M, 650k and 120 using the 
same number format, reflecting the values 10,000,000, 650,000 and 120 
respectively.  We can have no more than three format options in any 
given cell though.

However, one client’s request was to create a cell that would display four 
different number formats, reflecting billions (B), millions (M), thousands 
(K) and units. Since we can’t display this in standard number formatting, 
we are forced to use conditional number formats, with conditions 
specifying when to apply target number formats.

The second part of the client’s request was for the number format to 
continue onto a chart that the numbers were being reported.  Therefore, 
our challenge for this month is as follows: can you create a chart to 

present a row of numbers, where the number format of the chart axis 
contains four or more different conditions?  

Specific rules:

	 •	 It needs to change the number format into billions, millions, thousands or units depending on the numbers presented in the chart (at least 	
		  four different conditions)

	 •	 No macros or user defined functions are allowed

	 •	 Conditional formatting is not allowed (not expecting that one??).

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Beat the Boredom Challenge
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When we create lists or data in a workbook and make a report out of it, 
when we add or remove any data (e.g. add / remove rows or columns), 
it’s possible that the whole report may become inaccurate.  Excel has a 
solution for it, which is known as Dynamic Tables.

Why do we need Dynamic Tables or a Dynamic Range?  The answer is 
because whenever a list or data range is updated or modified, it is not 
certain that the report will be changed as per the data change. 

Basically, there are two main advantages of Dynamic Tables:

	 1.	 a dynamic range will update automatically, as per the data change(s)

	 2.	 PivotTables based on the dynamic table in Excel may be automatically updated when the pivot is refreshed.

So how do we create a Dynamic Tables in Excel?  We may use either Tables or the OFFSET function.

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at the 
concept of dynamic charts.

Charts and Dashboards

Here, we’ll select the Table range, then go to the Insert tab and choose Table, or CTRL + T:

A ‘Create Table’ dialog will pop up.  Since this data table has headers in the top row, you should check the box ‘My table has headers’.

The Table will now look like this:

Using Tables to Create Dynamic Tables
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Choosing the entire Table, we can then go to Insert tab and choose PivotTable.

The ‘Create PivotTable’ dialog will then appear.  We will then load the PivotTable into the same worksheet, choose ‘Existing Worksheet’ and click on 
a cell location, here, we will use cell D23.

Choose Quarter as Rows and BizSupplies as Values:
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This will produce the following PivotTable:

Then in the existing Table, if we add new sales data (as seen, Sep-19 and Dec-19):

The PivotTable will reflect newly added data, as seen under 2019: Qtr3 and Qtr4.

Dynamic Tables are used to make sure that whenever a data range is updated or modified, the report associated with it will be changed accordingly.   
An alternative treatment involves OFFSET.
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Now, whenever we refer to the dataset BS_Sales, it will point to the range D43:E51 which contains the BizSupplies quarterly sales.  If another row is 
added to the data, it will still point to the same range, as this range is static.  However, we may use the OFFSET function to make this range dynamic.

To do this, let’s select the range D43:E51 and navigate to the Formulas tab on the Ribbon, where we may then ‘Define Name’.

The ‘New Name’ dialog will appear.  I type the OFFSET formula into the ‘Refers to’ box as shown below:

Let’s break down the OFFSET function formula:

=OFFSET('Dynamic Tables'!$D$43,1,0,COUNTA('Dynamic Tables'!$D$43:$D$1000)-1,2)

	 •	 choose the starting cell, which, in this case, is ‘Dynamic Tables’!$D$43
	 •	 we need to type 1,0 as it will count how many rows or columns to go

	 •	 we also need to count whatever the data is in Column D, e.g. range D43:D1000 and use that as the number of rows, so use COUNTA 	
		  function and select ‘Dynamic Tables’$D$43:$D$1000
	 •	 since we do not want the first row (which is the Quarter header) to be counted, we have to subtract one [1]
	 •	 the number of columns will always be two [2].

To begin, let’s select the data and give it a name in the Name box, viz.

Using the OFFSET function
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If I go to the Formula tab and then click on ‘Name Manager’,

we may then click on the ‘Refers to’ field, where I can see the range of the Table:

If we add more data to the table (here as blue colour to make it clear) and then go back to Formula -> ‘Name Manager’ and click on the ‘Refers to’ 
field again, we will now see the range has been changed to cover the newly added data:

The table has now become dynamic.
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To recap, why do we need Dynamic Tables or Dynamic Ranges?  The reason is whenever a list or data range is updated or modified, it is not certain 
that the report will be changed as per the data change.  Dynamic Tables or Dynamic Range will help you avoid this problem.

A Dynamic Range in Excel is a named range.  An Excel Dynamic Named range is one of the more powerful techniques in Excel.  Let’s look at the 
example below:

vs.

In the first figure’s summation, the range is from E11:E18, while in the 
second figure’s total, it is showing as BizSupplies.  The reason is that the 
range B2:B10 has been named BizSupplies.

For a small set of data, it is not necessarily that a named range be applied.  
However, Dynamic Named Ranges make it much easier especially when 
you are working in larger set of data.  Dynamic Named Ranges save us 

from going back to find and select targeted range of cells.  Instead, we 
can just type the name which we have provided for that range.

Creating named ranges in Excel is straightforward. 

To do this, we may add a name for a range in the ‘Name Box’, after 
choosing the entire range that we wish to name:

Dynamic Named Ranges
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Alternatively, we may also go to the Formulas tab on the Ribbon:

Then, the ‘New Name’ dialog will pop up,  Here, we may fill in the ‘Name’, and select the range in the ‘Refers to’ field:

I can also create named ranges automatically when my data contains a large number of columns, by first choosing the whole data set, then click 
Formulas –> Name Manager –> Create from Selection.  The ‘Create Names from Selection’ dialog will appear, where I may choose ‘Top row’ as the 
column name to use as the name for the range: 

After that, when I choose the Formulas –> Name Manager, the list of names should be displayed:
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This is just the first step.  In a simple named range, it will take only the predetermined range.  In the case of data expansion, it will not expand 
dynamically.  Therefore, we need to create a Dynamic Range in Excel.  When we define an Excel Dynamic Named Range, as new items are added, the 
range will automatically expand. 

To create this, let’s apply data validation to the named range that has already been set, navigating to the Data tab on the Ribbon and choosing ‘Data 
Validation’:

Change the validation criteria as in the below dialog:

Now that the ‘Data Validation’ dialog for Quarter has been created, it displays all of the range in the Quarter column:
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However, if we add more values to the column, these newly added values will not appear in the dropdown cell.  This is because the range is not dynamic.

To fix and compare this, I create a new named range called Period, now using the OFFSET function as below, similar to the example provided with 
Dynamic Tables so that newly added values will be counted:

Then, we call the ‘Data Validation’ dialog.  This time, the ‘Source’ will be the named range which has just been created using the OFFSET function, 
i.e. Period:
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Here, we add values to the Quarter column.  As new reports appear, we may check that in the Period validation, new values are now displayed:

It’s a long article this month!  We couldn’t finish a discussion on dynamic 
charts without referring to November’s news.  In Excel for the web and 
Excel Desktop (Insiders Beta), charts should now respond to dynamic 
arrays.  This will make things simpler.

For those who have access, you may now create a chart with a data 
source range aligned to the result of an array formula.  The chart will 
now update to capture all data whenever the array recalculates, rather 
than being fixed to a specific number of data points.  Yippee!

In cells A4:B29 (purposely not placed in an Excel Table), we have entered the results of the Home Cookery & Poisoning (Joint Honours) vocational 
course.  Cell E1 contains an input number that specifies the top “X” students to chart, and the formula 

=INDEX(SORT(A4:B29,2,-1,FALSE),SEQUENCE(E1),{1,2})

has been entered into cell D4 as a dynamic array formula to summarise the said top X students and their respective marks.

Finally, a chart has been inserted linking to the dynamic range (cells D4:E6 in the above illustration) in the usual way (e.g. Insert -> Recommended 
Charts).  Nothing that exciting so far, but then, let’s change the vale in cell E1 to 10 (say):

For example, consider the following:

Dynamic Arrays
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or even 20:

More next month…

Last month, we looked at using the After, SearchDirection and SearchOrder parameters of the Find method.  But what if we needed an exact match?  
There are a few things we could match:

	 •	 matching the complete word

	 •	 matching the case of the word (i.e. the capitalisation)
	 •	 matching specific cell formatting.

Luckily, the Find method has parameters that can help us with that!  For this month, we will look at the first option (can you guess what we might 
do next month..?). 

The word field has been adjusted slightly to give us more interesting things to search (the changed squares are highlighted in yellow):

If we were to search “encounter” from cell C5 onwards, what would the result be?  Let’s give it a go:

Sub EncounterOfTheFirstKind()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Dim foundrange As Range

    Set foundrange = searchRange.Find("encounter", After:=Range("C5"))

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If

End Sub

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we consider finding “types” of exact matches.

Visual Basics
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It technically found “encounter” albeit within “rencounter”.  To force it to match the complete word, we would need to trigger the LookAt parameter.  
By defining it to be xlWhole, that will force it to look at the entire contents of the cell. 

Sub FindWholeWord()

    Dim searchRange As Range

    Set searchRange = Range("A1:E10")

    Dim foundrange As Range

    Set foundrange = searchRange.Find("encounter", After:=Range("C5"), LookAt:=xlWhole)

    If foundrange Is Nothing Then

        Debug.Print "not found!"

    Else

        Debug.Print foundrange

        Debug.Print foundrange.Address

    End If

End Sub

This change will land on the expected answer of cell A3.

Now, this is where things get interesting.  If we were to run another search immediately after without the LookAt:=xlWhole portion, it would still 
maintain the parameter setting.  This is because Excel saves this setting in the Find dialog.  Opening the dialog up, you may view the advanced settings 
by clicking the "Options > >" button:

There it is!  Therefore, whenever doing a search using the Find method in VBA, ensure that you always set the parameters for each Find because 
otherwise it will lead to unexpected results.

Next newsletter, we’re going to keep Finding things on a Case-by-Case basis...

Until then.
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We’ve written over 50 articles in this newsletter on Power Pivot topics and it has just occurred to us that we have not formally covered the SUM 
function, despite using it on many occasions.

In short, the SUM function adds all the numbers referenced.  The syntax is very straightforward: 

SUM(reference)

The SUM function serves as an aggregation function, which allows us to use it again in other measures such as CALCULATE.  For example, we will 
receive an error if we were to type this measure into the DAX editor:

=CALCULATE(
	 'Sales Table'[Total Sales],
		  'Calendar'[Year]=2020
		  )

We have to create another measure with SUM to aggregate the column data before using it in our CALCULATE measure:

=SUM('Sales Table'[Total Sales])

We can now insert the [Sales] measure that into our CALCULATE measure: 

=CALCULATE(
	 [Sales],
		  'Calendar'[Year]=2020
		  )

We continue our series on the Excel COM add-in, Power Pivot.  This month, we discuss the SUM and SUMX functions.

Power Pivot Principles
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The resulting PivotTable would be as follows: 

The SUM function is great at aggregating or summing entire columns, however can it cope with summing the product of two columns at once?  
Consider the following data: 

Shortfalls
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Let’s calculate the total revenue for our data. We will need to create three measures, [Unit Price], [Units Sold] and [Total Revenue].  These can be 
created as follows:

=SUM('Unit Price and Volume Sold'[Unit Price])

=SUM('Unit Price and Volume Sold'[Units Sold])

=[Unit Price 2]*[Units Sold 2]
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The resulting PivotTable yields: 

Strange, we didn’t think we made that much money either…

A quick and dirty check in our original data table reveals that we only made $72,678.89:

Upon further investigation it appears that the two columns are being aggregated first, then multiplied with each other to produce the total revenue 
(e.g. $32 x 2,241 = $72,563.58).  The actual total revenue for should be $9,747.77. 

It appears that the SUM function is aggregating column values based on the row labels (years, grand total) and then multiplying the Sum of # Units 
Sold with the Sum of Price Per Unit. This approach will not correctly calculate the total revenue. We will need a function that iterates the calculation 
row by row, cue the SUMX function.

The SUMX function requires the following syntax to operate:

SUMX(table, expression)

We can use the SUMX function to create the following measure:

=SUMX(
                'Unit Price and Volume Sold',
                'Unit Price and Volume Sold'[# of Units Sold] * 'Unit Price and Volume Sold'[Price Per Unit]
                )
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The resulting PivotTable yields:

Just to check here’s our quick and dirty calculation:
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We can see that the SUMX formula is correctly calculating the total 
revenue.  This is because it is calculating the total revenue for each row 
item individually ($2.99 x 474 = $1,417.26, $2.95 x 457 = $1,348.15, etc.), 
unlike the SUM function.  Therefore, we should use the SUMX function 
when we need Power Pivot to perform a calculation that needs to be 
iterated row by row.

For those of you thinking, why don’t we just use a calculated column?  
Yes, we could, but we have to be wary of resource management: this 
may take up more memory than is required.

More Power Pivot Principles next month.

It’s no secret that cleaning up data involves tidying up text strings so that 
we have consistent information to work with.  There are a few Text() 
functions in M which are particularly useful.  Having looked at true / false 

functions last month, this time I take a look at some Text() functions that 
can transform our data and we will give an example for each one.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we continue 
to look at some useful Boolean Text functions in M.

Power Query Pointers

Text.Insert(text as nullable text, offset as number, newText as text) as nullable text

This returns a text value with newText inserted into a text value starting at a zero-based offset.

This is a useful function for formatting a column to make it easier to read.  
In the next screenshot, we have a column of serial numbers.  If different 
sections of the serial number have specific meanings (for example 

department or product type), then it makes sense to break down the 
number to make it easier to read.  This also makes it clearer for other 
users who need to extract parts of the serial number to new columns. 

We may now use the M Text.Insert() formula to transform the column.

Text.Insert
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The formula used for our new column is 

= Text.Insert([Column1],4,"-")

It is also possible to nest this function so that we insert multiple characters, as shown in the formula, to create column Product Segments.

In this case, the formula is given by

= Text.Insert((Text.Insert([Product ID],9, "-")),13, "-"))

The Product ID has now been fully broken down into segments and is much easier to read and compare to other ID’s.

Text.PadStart(text as nullable text, length as number, pad as nullable text) as nullable text

This returns a text value padded at the start with pad to make it at least length characters.

This is a useful M function for presenting generated reference numbers correctly.  Note that if no ‘pad’ character is specified, then the default is a 
space.  In the next image, we have a list of generated reference numbers, but they all need to be 10 characters long.

Text.PadStart

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

It’s important to make sure that Power Query hasn’t ‘helpfully’ converted the reference to a number – if it has, delete the automatically created 
‘Changed Type’ step.  In this case, we have converted the column to text.

We may now create a new column using Text.PadStart().

The formula is 

= Text.PadStart([Column1],10,"0")

We are expanding all our references to be 10 characters, by adding zeros at the beginning (zero filling).

Our references are now presented correctly.
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Text.PadEnd(text as nullable text, length as number, pad as nullable text) as nullable text

This returns a text value padded at the end with pad to make it at least length characters.

This is not an M function we use a great deal, but it’s useful to know that text can be padded at either end.  We will add zeros to the end of our 
reference number so that each number is 15 characters in length.

Text.Remove(text as nullable text, removeChars as any) as nullable text

This removes all occurrences of a character or list of characters from a text value.  The removeChars parameter may be a character value or a list of 
character values.

This M function is very useful for getting rid of unwanted characters, so there is consistency.  On the next image, we have a list of contacts where the 
phone numbers have not been recorded consistently:

The M formula used is

= Text.PadEnd([Reference Number], 15, "0")

All the references are 15 characters long, and the zeros appear at the end of the references.

Text.PadEnd

Text.Remove
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We need to remove spaces, brackets and hyphens so that the numbers are all in the same format.

The phone numbers in the Phone No column are now displayed consistently.

Next month, we’ll look at some text functions that may be used to extract sections of a text string.

The M formula used here is

= Text.Remove([Phone Number], {" ", "(", ")", "-"})

This should remove all spaces, brackets and hyphens.  We have specified a list by the use of the curly brackets or braces ({ }).
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This doesn’t appear to be part of the “formal” Power BI updates, but 
Microsoft has announced a new way to explore and analyse live Power 
BI data in Excel.  Before now, you could only analyse live Power BI data in 
Excel using PivotTables (with the ‘Analyze in Excel’ feature) but with this 
feature, you can now use Excel tables to analyse live Power BI data too.

This is presently in Public Preview, with the capability being rolled out as we 
write.  This new connected experience enables you to export refreshable 
data to Excel from a Power BI visual.  The data loads into the spreadsheet 
grid so it’s easier to use for many users.  The data is refreshable because 
the generated Excel workbook contains a live connection to Power BI, so 
you can refresh the data without leaving Excel, plus this option also allows 

you to export more data into Excel from Power BI.

Apparently, this new ‘Export to Excel’ feature is one of many planned new 
connected features aimed at improving user productivity by enabling you 
to self-serve data while keeping your data refreshed in Excel and reducing 
your reliance on ad hoc static data requests.

To use this feature, go to any report in Power BI Service (or https://www.
powerbi.com), open ‘More options…’ on any Power BI visual and select 
‘Export data’ from the menu.  For example, in the following Workforce 
Demographics Report, let’s say you wish to analyse the ‘Recognized Revenue 
& Estimated Forecast from SalesForce & Backlog data’ (sic) in Excel:

In the resulting dialog, select the ‘Summarized data’ card and you will see a new option under the ‘File format:’ dropdown menu, ‘.xlsx (Excel) with 
live connection’.  Do note that in order to see the new .xlsx (Excel) with live connection option, you need to have Build permission for the underlying 
Power BI dataset.

Connected Excel Tables Now in Public Preview

After clicking Export, an Excel workbook containing the live Power BI data is downloaded to your computer.  When you open the Excel workbook, it 
will be opened in read-only mode until you select the ‘Enable Editing’ button in the warning message.
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To load the data to the Excel grid, click ‘Enable Content’ and an Excel table is visible on the grid.

Once you click ‘Enable Content’ and the data is loaded to the Excel grid, 
anyone with whom the workbook is shared may view, but not refresh, 
the data.  Before sharing the exported file with a colleague, you may need 
to open the file, pressing ‘Enable Content’, load the data into the Excel 

workbook and save the file.  If you don’t, the recipient will need to have 
Build permission on the underlying dataset to load the data when they 
open the file. 

Once set up, you see the live Power BI data as an Excel Table and use your familiar Excel spreadsheet formulae to perform ad hoc analysis or apply 
formatting to the data.
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It should be noted that the ExportHeaders tab shows the filters applied to the Power BI visual from which the data was exported from.  This tab is 
always visible on any new workbook of data exported from a Power BI visual.

You can view the Power BI connection in the Excel workbook by clicking 
‘Queries & Connections’ under the Data tab in Excel.  The Power BI 
connection is visible in the right pane, and you can update your Power 

BI data by clicking Refresh in the pane or right-clicking on the Excel 
Table and selecting Refresh.  Any formatting applied to the Excel Table is 
preserved after the data is refreshed.

If you are feeling a little more sophisticated, you can view the DAX statement behind the Excel Table under ‘Connection Properties’ in Excel:

The new .xlsx (Excel) with live connection option supports up to 500,000 
rows of data.  This is a substantial increase over the 150,000 rows 
supported in static export scenarios.  According to Microsoft, increasing 
the number of rows in export has been one of the top requests regarding 

exporting.  Furthermore, since the export is live and connected, export 
users can be more efficient because they don’t need to recreate their 
analysis from scratch.  Instead, they can save a copy, refresh their data, 
and immediately start their analysis. 

The general requirements for using this feature are as follows:

	 •	 the ‘Allow XMLA endpoints and Analyze in Excel with on-premises datasets’ tenant setting has to be enabled

	 •	 you must have Build permissions to the Power BI dataset or have at least a Contributor role in a Power BI workspace

	 •	 you must have a Power BI license, such as Free, Pro or Premium Per User (PPU)

	 •	 this feature is available for use in both Excel Desktop and Excel for the web.

The December update was released too late to make January’s newsletter, but for completeness, we detail it here.  This update saw a variety of 
new DAX functions, updated slicer type formatting and brought Metrics to the Windows application. 

Power BI Updates
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The full list is as follows:

Reporting

	 •	 Slicer type formatting moved to Format pane

Modelling

	 •	 Making it easier to do comparison calculations

Data connectivity and preparation

	 •	 Anaplan (connector update)

	 •	 Azure Databricks, Databricks (connector update)

	 •	 CData Connect Cloud (new connector)

	 •	 Cosmos DB V2 (new connector)

	 •	 Dremio Cloud (connector update)

	 •	 Google BigQuery (Azure AD) (new connector) 

Service

	 •	 Power BI org app Multiple Audiences will be Generally 		
		  Available later in 2023

	 •	 Announcing the deprecation of ‘Getting Started’ in the  
		  Expanded View of the Power BI Service

	 •	 Upcoming changes to the ‘Get Data’ experience in the Power BI  
		  Service

Mobile

	 •	 Track your Metrics on the Windows app

Developers

	 •	 Dynamically setting data chunk size

Visualisations

	 •	 New visuals in AppSource

	 •	 Update on Charticulator status.

Let’s look at each in turn.

Previously, to change a slicer’s type, for example changing from relative 
date to a slider, these settings were only available in the visual header 
and only on hover.  In addition, to change a slicer to ‘horizontal’ required 
users to first choose ‘list’ from the visual header to see the option in the 
Format pane and then use said pane to swap the orientation.

Now, these settings live in one place in the Format pane making it easier 
to discover and change between slicer types consistently.  And for the 
record, do note that the aforementioned ‘horizontal’ has now been 
renamed to ‘tile’ based upon user feedback.

Now:

Previously:

Slicer type formatting moved to Format pane
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Another added benefit with this change is the new Mobile formatting options now have access to this setting too.  Users can quickly update their 
Mobile layout slicers to use tile to be more mobile friendly.

This update saw Microsoft introduce multiple new functions for DAX, targeted at making it easier to do comparison calculations in Power BI.   
The new functions were as follows:

	 •	 INDEX retrieves a result using absolute positioning
	 •	 OFFSET retrieves a result using relative positioning
	 •	 WINDOW retrieves a slice of results using absolute or relative positioning.

These functions also come with two helper functions called ORDERBY and PARTITIONBY.  By our reckoning, that now takes the total number of DAX 
functions to 357.

These functions will make it easier to perform calculations such as:

	 •	 comparing values against a baseline or finding another specific entry (using INDEX)
	 •	 comparing values against a previous value (using OFFSET)
	 •	 adding a running total, moving average or similar calculations that rely on selecting a range of values (using WINDOW).

INDEX allows you to perform comparison calculations by retrieving a row that is in an absolute position.  This will be most useful for comparing values 
against a certain baseline or another specific entry.

If you are familiar with the SQL language, you will note that these 
functions are very similar to SQL window functions.  The functions 
released in this update perform a calculation across a set of table 
rows that are in one way or another related to the current row.  These 
functions are different from SQL window functions, because of the DAX 
evaluation context concept, which will determine what is the “current 
row”.  Moreover, the functions introduced will not return a value but 
rather a set of rows which can be used together with CALCULATE or 
an aggregation function like SUMX (see elsewhere in this month’s 
newsletter) to calculate a value.

Further, it should be noted that this group of functions is not pushed 
to the data source, but rather they are executed in the DAX engine.  
Additionally, Microsoft has stated it has seen much better performance 

using these functions compared to existing DAX expression to achieve 
the same result, especially when the calculation requires sorting by non-
continuous columns.

The DAX required to perform these calculations is simpler than the DAX 
required without them. However, while these new functions are very 
powerful and flexible, they still require a fair amount of complexity to 
make them work correctly.  That is because Microsoft opted for high 
flexibility for these functions.  However, the Powers that Be have 
stated that they recognise there is a need for easier to use functions 
that sacrifice some of the flexibility in favour of easier DAX.  With this in 
mind, these functions now released should be seen as “a stepping stone, 
a building block if you will” towards Microsoft’s goal to make DAX easier.

Let’s take a look at them now. 

Making it easier to do comparison calculations

INDEX
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Consider the following example.  Below is a table of customer names and birth dates whose last name is “Garcia”:

Now, imagine you wanted to find the oldest customer for each last name.  Therefore, for the last name “Garcia” that would be Adriana Garcia, born 
December 4th, 1957.  You can add the following calculated column on the DimCustomer table to achieve this goal and return the name:

Oldest Customer of LastName = SELECTCOLUMNS(INDEX(1, DimCustomer, ORDERBY([BirthDate]), PARTITIONBY([LastName])), [FullName])

This would return the following result:

In the example above, we showed only customers whose last name is “Garcia”.  However, the same calculated column works on a set that has more 
than one last name:

As you can see in the screenshots above, the full name of the oldest 
person with that last name is returned.  That’s because we instructed 
INDEX to retrieve the first result when ordering by birth date, by 
specifying one [1].  By default, the ordering for the columns passed 

into OrderBy is ascending.  If we had specified two [2], we would have 
retrieved the name of the second oldest person with the last name 
instead, and so on.
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Now, let’s say you wanted to compare how well each colour is doing against the colour above it in the chart.  You could write a complicated DAX 
statement for that, or you can now use OFFSET to accomplish this goal more simply, viz.

TotalSalesDiff = IF(NOT ISBLANK([TotalSales]), [TotalSales] - CALCULATE([TotalSales], OFFSET(-1, FILTER(ALLSELECTED(DimProduct[Color]), NOT 
ISBLANK([TotalSales])))))

This will return the following result:

As you can see the newly added bars calculate the difference for each 
colour compared to the one just above it in the chart.  That’s because 
the DAX formula specified -1 for the first parameter to OFFSET.  If we 
had specified -2 we would have made the comparison against the colour 

above each colour, but skipping the one right above it, so effectively the 
sales for the grey colour would have been compared against the sales for 
products that were black, etc.

	 •	 These helper functions may only be used in functions that accept an orderBy or partitionBy parameter, which are the functions introduced 	
	 	 above:

	 •	 the PARTITIONBY function defines the columns that will be used to partition the rows on which these functions operate

	 •	 the ORDERBY function defines the columns that determine the sort order within each of a window function’s partitions specified by 	
	 	 PARTITIONBY.

ORDERBY and PARTITIONBY

OFFSET allows you to perform comparison calculations more readily by 
retrieving a row that is in a relative position from your current position.  
This will be most useful for comparing across something else than time, 
for example across regions, cities or products.  For date comparisons, for 

example, comparing the sales for this quarter against the same quarter 
last year there are dedicated Time Intelligence functions in DAX already.  
That doesn’t mean you cannot use OFFSET to do the same, but it is not 
the immediate scenario.

So what is the scenario for OFFSET?  Consider the following.  Here’s a Bar chart that shows total sales by product colour:

OFFSET

Had we specified -1 or changed the sort order we would have returned the youngest person instead:

Youngest Customer of LastName = SELECTCOLUMNS(INDEX(1, DimCustomer, ORDERBY([BirthDate], DESC), PARTITIONBY([LastName])), [FullName])

is equivalent to:

Youngest Customer of LastName = SELECTCOLUMNS(INDEX(-1, DimCustomer, ORDERBY([BirthDate]), PARTITIONBY([LastName])), [FullName])

Notice that INDEX relies on two other new helper functions called ORDERBY and PARTITIONBY.
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WINDOW allows you to perform calculations that rely on ranges of results (“windows”), such as a moving average or a running sum.  For example, 
the below Column chart shows total sales by year and month:

This version of Power BI connector for Anaplan includes backend changes for compatibility with ongoing Anaplan infrastructure updates.  There is no 
change to user facing connector features.

The Azure Databricks and Databricks connectors now support native queries.

Now, let’s say you wanted to add a moving average for the last three months of sales including the current.  For example, for September 2017, you 
would expect the result to be the average sales of July, August and September in 2017 and for February 2018, we would expect the result to be the 
average sales for December 2017, January 2018 and February 2018.

To meet this requirement, you could write a complicated DAX statement or you can now use WINDOW to accomplish this goal using a simpler DAX 
statement:

MovingAverageThreeMonths = AVERAGEX(WINDOW(-2, 0, ALLSELECTED(DimDate[CalendarYear], DimDate[MonthName], 
DimDate[MonthNumberOfYear]), ORDERBY(DimDate[CalendarYear], ASC, DimDate[MonthNumberOfYear], ASC)), [TotalSales])

This will return the following result:

The newly added line correctly calculates the average sales over three 
months (including the current month).  This release on a so-called 
‘relative window’: the first parameter to WINDOW is set to -2, which 
means that the start of the range is set two months before to the current 
month (if that exists).  The end of the range is inclusive and set to zero 

[0], which means the current month.  Absolute windows are available as 
well, as both the start and end of the range can be defined in relative or 
absolute terms.  Notice that WINDOW relies on two other new functions 
called ORDERBY and PARTITIONBY too.

WINDOW

Anaplan (connector update)

Azure Databricks, Databricks (connector update)
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CData Connect Cloud brings real-time data access to hundreds of new 
cloud applications, databases and APIs from within Power BI.  CData 
Connect Cloud helps everyone can access the data they need.  Real-time 

data connectivity in the cloud means no installation, delays or complex 
data pipelines.  This allows you to take advantage of the most current 
data available to make real-time data driven decisions using Power BI.

The new V2 connector will support querying the Cosmos DB transactional 
store in both DirectQuery and Import modes.  The DirectQuery mode 
will enable query pushdown, including aggregations to the Cosmos DB 
container when a filter on partition key is specified.

The DirectQuery mode in the V2 connector will be helpful in scenarios 
where Cosmos DB Container data is large and it is not feasible to import 
it all to Power BI cache in the Import mode.  It will also be helpful in 

user scenarios where real-time reporting with the latest Cosmos DB 
data is a requirement.  In addition to supporting DirectQuery mode, 
the V2 connector includes performance optimisations related to query 
pushdown and data serialisation.

It should also be noted that due to a known issue that is presently being 
fixed and deployed, support for this feature in Premium and end-to-end 
cloud refresh may not work until the very near future.

This release contains a fix that allows query folding on data containing Decomal data types to be pushed down to Dremio.  This improves performance 
by reducing the volume of data Power BI is required to read.

This update sees the release of a new Google BigQuery connector leveraging Azure Active Directory authentication.  Users can use Azure Active 
Directory-based Single Sign-On through Power BI Service and Gateway using this connector.

Following Microsoft’s last announcement in August of launching the 
public Preview of Multiple Audiences for Power BI org apps, at the time 
of this update they further announced that this feature will be Generally 

Available early in 2023.  As stated, with Multiple Audiences for an app 
Power BI App author can create Multiple Audience groups within the 
same app and assign different permissions to each group.

Power BI Service’s expanded view currently gives you the option to 
view ‘Getting Started’ content at the end of your Home Page.  From the 
‘Getting Started’ section, you can use information on how to get started 
using Power BI, tips and tricks on how to create / utilise reports and 
dashboards, etc.  Due to low usage from Power BI users, support for 

the ‘Getting Started’ section will be removed and you will no longer be 
able to access the content above through this area.  Retirement of the 
‘Getting Started’ section will open Power BI Service’s expanded view 
Homepage for new additions in the future.

Although you will not be able to view the ‘Getting Started’ content 
directly through Power BI Service, the content is still publicly available.  
If you are a new Power BI user, some of the content from the ‘Getting 

Started’ section will be available to you through your ‘Recommended’ 
carousel.  If you are not a new user, the ‘Getting Started’ content is still 
publicly available to you through Microsoft Learn.

Since mid-December, the ability to view ‘Getting Started’ content through the expanded view from Power BI Service will be retired.

CData Connect Cloud (new connector)

Cosmos DB V2 (new connector)

Dremio Cloud (connector update)

Google BigQuery (Azure AD) (new connector)

Power BI org app Multiple Audiences will be Generally Available later in 2023

Announcing the deprecation of ‘Getting Started’ in the Expanded View of the Power BI Service

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

As mentioned in the last update, Microsoft is in the process of removing 
the older ‘Get Data’ page in the Power BI service in favour of new, 
comparable features available within workspaces.  The change that 

will remove the entry points to the old ‘Get Data’ page, which is shown 
before reference, will be slowly rolling out early in 2023.

Going forward, you’ll be able to access comparable features within 
workspaces.  If you want to upload a file to Power BI, such as a .pbix, 
.xlsx, or .rdl files to your workspace, you can use the Upload option that 
was released in November.  This option lets you upload files from your 

local computer or connect to files on OneDrive or a SharePoint site.  
With this change, you’ll no longer be able to connect to files on personal 
OneDrive accounts.

If instead you want to create a dataset from Excel or CSV data, you can now access that functionality through the New -> Dataset option in the 
workspace you want to create the dataset in.

Upcoming changes to the ‘Get Data’ experience in the Power BI Service
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At the same time as the older ‘Get Data’ experience is removed, Power BI 
will also be updating this Dataset option to take you to a new page with 
options to create a dataset off an Excel, CSV or pasting in data.  Once you 

select the file, the behaviour used to generate the dataset is the same 
as previously used on the ‘Get Data’ page.  Once the dataset is created, 
you’ll be taken to the dataset’s details page in the Data hub.

These changes will be rolling out slowly, so you may not see the update immediately.

Now you can monitor your Power BI metrics and scorecards and even check in progress, directly from the Windows application.

This update has enhanced the ‘fetch more data’ API to allow report authors to set the data chunk size dynamically by using the new property 
dataReductionCustomization.  This is available with the new 5.2 API release.

The following are new visuals within this update:

	 •	 100% Clustered Stacked Bar Chart (Standard)

	 •	 100% Clustered Stacked Column Chart (Standard)

	 •	 3DBI

	 •	 Advanced Line Chart (Standard)

	 •	 Aimplan Planning and Reporting Visual

	 •	 Bubble Chart with Categorical Data (Standard)

	 •	 Definitive Logic Advanced Gantt Chart

	 •	 Dual X-axis Bar Chart (Standard)

	 •	 Dual X-Axis Combo Chart (Standard)

	 •	 Dual Y-Axis Column Chart (Standard)

	 •	 Dual Y-Axis Combo Chart (Standard)

	 •	 Excalibur

	 •	 GANTT by Lingaro

	 •	 Horizontal Bullet Chart (Standard)

	
	 •	 kpi emoji

	 •	 Likert Scale (Standard)

	 •	 Lollipop Bar Chart (Standard)

	 •	 Lollipop Column Chart (Standard)

	 •	 Merged Bar Chart (Standard)

	 •	 Multiple Vertical Line Chart (Standard)

	 •	 OneTax-PowerBIvisual

	 •	 Overlapping Bar (Standard)

	 •	 Overlapping Column (Standard)

	 •	 Pie Chart with Full Legend Label (Standard)

	 •	 Population Pyramid (Standard)

	 •	 swColorMap_twoLevels

	 •	 Vertical Bullet Chart (Standard)

	 •	 verticalText by sio2Graphs.

Track your Metrics on the Windows app

Dynamically setting data chunk size

New visuals in AppSource
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Finally, Microsoft has provided a status update on the Charticulator 
custom visual and the visual creation tool it’s built upon.  The Microsoft 
Research team which built the tool has moved on to new projects and 
ownership of the technology is being transitioned to a team in Power 

BI.  Microsoft will continue to fix major bugs and actively maintain the 
quality of the current tool, although feature-level development has been 
put on hold for now. 

That’s it for this month: more anon.

Update on Charticulator status

This release sees the announcement of ‘Formula Suggestions’ and 
‘Formula by Example’ for Excel web users – a couple of exciting 
capabilities designed to help save you time and learn more about Excel 
formulae as you use them.  Also for web users are suggested links, the 
IMAGE function and a new Search bar in the Queries pane.  For Windows 

users, a new keyboard shortcut is available to open the Power Query 
editor (wow), and Insiders users on Windows can now get data from 
dynamic arrays and create nested Power Query data types to better 
organise data.

The full list is as follows:

Excel for the web

	 •	 Formula Suggestions

	 •	 Formula by Example

	 •	 Suggested Links

	 •	 Add Search bar in Queries pane

	 •	 IMAGE function	
	

Excel for Windows

	 •	 Add keyboard shortcut to open the Power Query editor 

	 •	 Create nested Power Query data types (Insiders) 

	 •	 Add Get Data from Dynamic Arrays (Insiders) 

	 •	 IMAGE function

Excel for Mac

	 •	 IMAGE function.

Let’s plough through.

New Features for Excel

After you type the “=” sign in a cell or the Formula bar, Excel will 
automatically suggest a formula based upon contextual insights from 
your data.  Formulae that can be suggested use SUM, AVERAGE, 

COUNT, COUNTA, MAX and MIN.  Presently, there is support for the 
English language in Excel for the web only.  This feature is rolling out to 
production for web users.

Formula Suggestions
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Also coming to Excel for the web, as you are performing manual and 
repetitive data entry in a column, Excel will now suggest you to fill the 
entire column with a formula when a pattern has been identified.  This is 
similar to Flash Fill, but now, instead of static text - now formulae can be 

suggested.  It’s like dynamic Power Query functionality without needing 
to refresh.

Simply start typing in the column and wait for the dialog to pop up:

You may then review the formula suggested:

Clicking Apply will insert the suggested formula into the range.

Formula by Example
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Also new to Excel for the web, Suggested Links will allow a new Cloud workbook store data which will detect when an external link to a Cloud 
workbook is broken.  It will then suggest a new location in order to fix the broken link. This feature is currently rolling out to Production.

For example, here in Excel for the web, the software has detected an issue:

Clicking on the ellipsis (…) in the ‘Workbook Links’ pane will allow you to ‘Change source’ viz.

In the ‘Change Source’ dialog, selecting ‘Suggested’ prompts you with a suggested file to link to:

If satisfied with the suggestion, clicking Select will change the source and rectify the error.

Suggested Links
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Another new feature for Excel for the web is the addition of the Search bar in the Queries search pane:

The IMAGE function is now available in Excel for the web, Excel for 
Windows and Excel for Mac.

Your images can now be part of a worksheet in pretty much any version 
of Excel (either for the web, or some Insiders Beta variant), instead of 

floating on top of the cells.  You may move and resize cells, sort and filter, 
and work with images within an Excel table.  This improvement unlocks 
and facilitates many new scenarios, such as tracking inventories, creating 
employee dashboards or building games and brackets – something I 
know you are all especially keen to do!

You may insert a sphere into a cell by typing 

=IMAGE(“https://support.content.office.net/en-us/media/2d9e717a-0077-438f-8e5e-f85a1305d4ad.jpg”, “Sphere”)

The IMAGE function inserts images into cells from a source location, along with alternative text.  Its syntax is as follows:

IMAGE(source, [alt_text], [sizing], [height], [width])

The arguments are as follows:

	 •	 source is required, and represents the URL path of the image file, using an https protocol (it should be noted that supported file formats 	
		  include BMP, JPG, JPEG, GIF, TIFF, PNG, ICO and WEBP).  Upon tinkering, cell references within the workbook appear to be recognised too

	 •	 alt_text is the first optional argument.  This is the alternative text that describes the image (for accessibility purposes)

	 •	 sizing is also an optional parameter and specifies the image dimensions.  There are several possible values:

			   �	 0: fit the image in the cell and maintain its aspect ratio (default)

			   �	 1: fill the cell with the image and ignore its aspect ratio

			   �	 2: maintain the original image size, which may exceed the cell boundary

			   �	 3: customise the image size by using the height and width arguments (see below)
	 •	 height and width are optional arguments.  These define the height and width respectively of the image only when using sizing option 3 	
		  (see above).

Add Search bar in Queries pane

IMAGE function

Examples
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Alternatively, you may insert a cylinder into a cell as follows:

	 •	 Copy and pasting the following URL into cell B1:  
		  https://support.content.office.net/en-us/media/35aecc53-b3c1-4895-8a7d-554716941806.jpg 
	 •	 Type “Cylinder” in cell B2
	 •	 Enter the formula =IMAGE(B1,B2,0) in cell A3 and pressing the ENTER key.

As highlighted back in October’s newsletter, there are areas for improvement, such as:

	 •	 if the URL to the image file you are using is pointing to a site that requires authentication, the image will not render

	 •	 zooming in and out with images in cells may distort the images

	 •	 moving between platforms (for example, Windows and Mac) may result in irregular image rendering. 

You have simply no idea the debate that was triggered from this little gem.  Finally, it was decided that ALT + F12 (Windows 32-bit) and Option + F12 
(Mac) will open the Power Query editor.

Data may now be organised better, by creating nested data types (Power Query Data Types with multiple levels).  This feature is currently rolling out 
to Insiders users for Windows.

Known issues

Add keyboard shortcut to open the Power Query editor 

Create nested Power Query data types (Insiders) 
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‘Get Data from Table / Range’ now supports importing data from Dynamic Arrays.  This means you may load said arrays into Power Query and 
transform your data, just as you can with static ranges or data from Excel Tables.  This feature is currently rolling out to Windows Production.

The updated version of the grid with all the new features is fast becoming too complicated to show clearly here.  Nonetheless, you can find the 
interactive links at aka.ms/ExcelFeaturesFlyer. 

Add Get Data from Dynamic Arrays (Insiders) 
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More next month, we’re sure.

This function returns a number that is rounded up to the nearest integer or to the nearest multiple of significance.  Regardless of the sign of the 
number, the number is rounded up.  However, if the number or the significance is zero (0), zero is returned.

The ISO.CEILING function employs the following syntax to operate:

ISO.CEILING(number, [significance])
The ISO.CEILING function has the following arguments:

	 •	 number: this is required and represents the value you wish to round
	 •	 significance: this argument is optional.  This is the multiple used for rounding.

It should be further noted that: 

	 •	 if either argument is nonnumeric, ISO.CEILING returns the #VALUE! error value
	 •	 this function should not be confused with CEILING, which may round up or down, depending upon the arguments used

	 •	 this function is not recognised by Excel’s AutoComplete.  Do not be alarmed if it is not offered as a suggested function; it is still a current  
		  and valid function in Excel

	 •	 if significance is omitted, its default value is one (1)

	 •	 the absolute value of the multiple is used, so that the ISO.CEILING function returns the mathematical ceiling irrespective of the signs of  
		  number and significance

	 •	 some modellers believe CEILING.MATH replaced ISO.CEILING after initial beta testing, but this is not the case.  These two functions are  
		  similar, but different.

The A to Z of Excel Functions: ISO.CEILING
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Please see our example below: 

At the time of writing, there are 12 IS functions, i.e. functions that give rise to a TRUE or FALSE value depending upon whether a certain condition 
is met:

	 1. 	 ISBLANK(reference): checks whether the reference is to an empty cell

	 2. 	 ISERR(value): checks whether the value is an error (e.g. #REF!, #DIV/0!, #NULL!).  This check specifically excludes #N/A
	 3. 	 ISERROR(value): checks whether the value is an error (e.g. #REF!, #DIV/0!, #NULL!).  This is probably the most commonly used of these  
		  functions in financial modelling

	 4. 	 ISEVEN(number): checks to see if the number is even
	 5. 	 ISFORMULA(reference): checks to see whether the reference is to a cell containing a formula

	 6. 	 ISLOGICAL(value): checks to see whether the value is a logical (TRUE or FALSE) value
	 7. 	 ISNA(value): checks to see whether the value is #N/A.  This gives us the rather crude identity ISERR + ISNA = ISERROR
	 8. 	 ISNONTEXT(value):  checks whether the value is not text (N.B. blank cells are not text)
	 9. 	 ISNUMBER(Value): checks whether the value is a number

	 10. 	 ISODD(number): checks to see if the number is odd.  Personally, I find the number 46 very odd, but Excel doesn’t

	 11. 	 ISREF(value): checks whether the value is a reference
	 12. 	 ISTEXT(value): checks whether the value is text.

We covered many of these last month.  As stated above, the ISODD function checks whether a number is odd.  It has the following syntax:

ISODD(number)

The ISODD function has the following argument:

	 •	 number: this is required and represents the number for which you wish to determine whether it is odd.  If number is not an integer, it is 	
		  truncated (i.e. not rounded, simply ended).

It should be further noted that: 

	 •	 if number is nonnumeric, ISODD returns the #VALUE! error value.

The A to Z of Excel Functions: ISODD
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Please see more examples below:

The more observant amongst you will note we have not included this in 
our list of the 12 IS functions.  This is because this doesn’t necessarily play 
nicely in Excel on its own like the others (it likes to play with LAMBDA).  

This new function checks whether the value is missing, and returns 
either TRUE (value is missing) or FALSE (value is not missing) accordingly.  
The syntax is simple:

ISOMITTED(argument)

where:

	 •	 argument is a required parameter, and is the value you want to test, which may be based upon a LAMBDA.

The example

=LAMBDA(arg1, [arg2], IF(ISOMITTED(arg2), arg1, arg2))

will return the value of arg1 if arg2 is omitted (this is why arg2 is in square brackets as it is an optional argument); otherwise, it will return the value 
of arg2.  

Simply put, this lambda will return the value of arg1 if arg2 is omitted; otherwise, it will return the value of arg2.  I’d like to have called this lambda 
function Jason as it sort of checks if his args are naught, but sadly it’s not Friday 13th…

The A to Z of Excel Functions: ISOMITTED
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The A to Z of Excel Functions: ISOWEEKNUM

The ISO week date system is effectively a leap week calendar system 
that is part of the ISO 8601 date and time standard issued by the 
International Organization for Standardization (ISO) since 1988 (last 
revised in 2004) and, before that, it was defined in ISO (R) 2015 since 

1971.  It is used (mainly) in government and business for fiscal years, as 
well as in timekeeping.  This was previously known as "Industrial date 
coding".  The system specifies a week year atop the Gregorian calendar 
by defining a notation for ordinal weeks of the year. 

An ISO week-numbering year (also called ISO year informally) has 52 or 53 full weeks.  The extra week is sometimes referred to as a leap week, 
although ISO 8601 does not use this term. 

Weeks start with Monday.  Each week's year is the Gregorian year in which the Thursday falls.  The first week of the year, hence, always contains 4 
January.  ISO week year numbering therefore slightly deviates from the Gregorian for some days close to 1 January. 

This function returns the number of the ISO week number of the year for a given date.

The ISOWEEKNUM function employs the following syntax to operate:

ISOWEEKNUM(date)

The ISOWEEKNUM function has the following arguments:

	 •	 date: this is required and represents the date-time code used by Excel for date and time calculations.

It should be further noted that: 

	 •	 Microsoft Excel stores dates as sequential numbers so they can be used in calculations.  By default, January 1, 1900 is serial number 1, and  
		  January 1, 2008 is serial number 39,448 because it is 39,447 days after January 1, 1900

	 •	 if the date argument is not a valid number, ISOWEEKNUM returns the #NUM! error value
	 •	 if the date argument is not a valid date type, ISOWEEKNUM returns the #VALUE! error value.

Please see our final example for this month below:

More Excel Functions next month.
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Earlier this newsletter, we asked if you could create a chart that would 
have the number format of the chart axis dynamically change when the 
values being charted increase or decrease.

Chart axes will, by default, take on the number formatting of the cells in 
the first data series that it uses.  This means that if you set the number 

formatting in the data cells, you can have up to three different number 
formats built into the cell.  However, if you use conditional formatting 
to get the fourth format, the conditional formatting doesn’t flow onto 
the chart!

We mentioned some specific rules:

	 •	 It needs to change the number format into billions, millions, thousands or units depending on the numbers presented in the chart (at  
		  least four different conditions)

	 •	 No macros or user defined functions are allowed

	 •	 Conditional formatting is not allowed (not expecting that one??).

The last condition might have caught you out as we have shown previously how to create multiple custom number formats using conditional 
(number) formatting.  So how did you fare?

Beat the Boredom Suggested Solution

The trick here is to take advantage of one of the perennial oft frowned 
upon functions in Excel.  The OFFSET function, amongst its other neat 
features, can be used inside a named range to create a dynamic range 
that can select different rows depending on a condition that we set 

up.  Therefore, if we set up four [4] rows, each with their own number 
format, then we can create a named range that chooses which row to 
get the chart data from, viz.

When you change the numbers, the named range will automatically pick up the correct row, and the chart axis will update in kind:

Suggested Solution
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Earlier this newsletter, we asked if you could create a chart that would 
have the number format of the chart axis dynamically change when the 
values being charted increase or decrease.

Chart axes will, by default, take on the number formatting of the cells in 
the first data series that it uses.  This means that if you set the number 

formatting in the data cells, you can have up to three different number 
formats built into the cell.  However, if you use conditional formatting 
to get the fourth format, the conditional formatting doesn’t flow onto 
the chart!

We mentioned some specific rules:

	 •	 It needs to change the number format into billions, millions, thousands or units depending on the numbers presented in the chart (at  
		  least four different conditions)

	 •	 No macros or user defined functions are allowed

	 •	 Conditional formatting is not allowed (not expecting that one??).

The last condition might have caught you out as we have shown previously how to create multiple custom number formats using conditional 
(number) formatting.  So how did you fare?

Beat the Boredom Suggested Solution

The trick here is to take advantage of one of the perennial oft frowned 
upon functions in Excel.  The OFFSET function, amongst its other neat 
features, can be used inside a named range to create a dynamic range 
that can select different rows depending on a condition that we set 

up.  Therefore, if we set up four [4] rows, each with their own number 
format, then we can create a named range that chooses which row to 
get the chart data from, viz.

When you change the numbers, the named range will automatically pick up the correct row, and the chart axis will update in kind:

This is our attempt to find a workaround to get conditional number formatting into the chart axis.  By no means are we claiming this is the only way 
to do it – if you have a more elegant solution, please let us know!

Until next time.

Suggested Solution
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 20 - 22 Mar 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 27 Mar 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Online (Australia) Financial Modelling 28 - 29 Mar 2023 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes

Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we look at the CTRL 
and ALT keys:
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Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Keystroke What it does

CTRL + ALT + SHIFT + F2 Print

CTRL + ALT + SHIFT + F4 Close application

CTRL + ALT + SHIFT + F9 Recalculation: full rebuild

CTRL + ALT + SHIFT + TAB Outdent (it’s a word apparently – look it up!)

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.


